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Getting Started 
 

Before installing Forex Trend Detector on your computer and commencing 

trading on a real account, please read this carefully – your future profits could 

depend on it. 

Trading FOREX entails risk and any instance of negligence or inattention 

can easily result in significant losses! 

1. We strongly recommend that you operate a demo account before 

trading with real money. This will help you become familiar with the way 

Forex Trend Detector operates, before you commit genuine funds to a real 

money account. 

2. Please be extremely careful when determining trading volumes and setting 

automatic risk management parameters! 

3. If you suspect that Forex Trend Detector is operating incorrectly, please stop 

trading and contact us immediately! 

 

WHAT YOU MUST KNOW BEFORE USING  

FOREX TREND DETECTOR 

 
 Forex Trend Detector supports only EURUSD currency pair at the moment.  

 Forex Trend Detector is compatible with all MetaTrader 4 brokers, as well as 

with brokers that use ECN-type order fulfilment. You do not need to change 

any settings. 

 Forex Trend Detector automatically recognises whether your broker offers 

four- or five-digit quotes. You don’t need to change any settings. If your 

broker offers five-digit quotes, you don’t have to multiply TakeProfit and 

StopLoss values by 10. 

 Avoid launching and closing your trading terminal too often. Ideally, it should 

work without interruption from market opening on Monday to closure on 

Friday. 

 For problem-free operation, use a computer with a minimum configuration of: 

2 GHz processor, 4 GB RAM, and Windows XP, Windows Vista, Windows 7 or 

Windows 8 operating system. 
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 A stable internet connection is essential to ensure that Forex Trend Detector

operations reliably.

 The amount of profit you can make using Forex Trend Detector will depend on

the spreads offered by your broker. The recommended spread for EURUSD is

under 1.5 pips.

 Look out for brokers who steal pips and try to fulfil orders at prices that are 1 
or 2 pips less favourable than they ought to be. If this happens, narrow 
spreads advertised as 1 pip can easily work out at 3 or 5 pips, thus reducing 
the profits that Forex Trend Detector can make. Be particularly cautious of 
new brokers who advertise aggressively on the internet. Choose only trusted 
brokers who are well established on the market and have good feedback from 
their customers. Click the link below to view the largest data base of brokers’ 
reviews and ratings:

http://www.profitf.com/forex-brokers/

The MetaTrader 4 Trading Platform 

Forex Trend Detector operates on the MetaTrader 4 trading platform. MT4 is a 
free trading platform available through most FOREX brokers. 

If you don’t have MT4 installed on your computer, you can download a copy by 

going to one of the following brokers and requesting a demo account:  

www.thinkforex.com 
www.hotforex.com 

www.thinkforex.com 
www.fxopen.com 

www.alpari.ru 

As well you can check the link below and find a lot of information for 

different MT4 brokers:  

http://www.profitf.com/forex-brokers/

This list is for reference only. We are not affiliated with these any other brokers. 

Suffice to say, the brokers listed above have good reputations and reasonable 
spreads. 
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Installing MetaTrader 4 
 

If you’re familiar with MT4 and already have a broker account, just take a quick 

look through this section to refresh your memory. 
 
 

 
 

 
 

After installation, you’ll be asked to create a demo account. Fill in the details and 

select an amount to deposit. Enable "Agree to subscribe to your newsletters" and 
then click Next. 
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The program will ask you to select a trade server to connect to. Select the server 
and click Next. In the next window, click Finish. 
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Your demo account is now open. Close MT4 so that you can install Forex Trend 

Detector. 
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Installing Forex Trend Detector 
 

There are two ways to install our software: 

Automatic Installation Using 

ForexTrendDetector_Installer_v3.0.exe 

 

 After logging in to the member zone with the username and password provided, 
download "ForexTrendDetector_Installer_v3.0.exe" from your personal download 
page to a convenient location on your computer. 

 Install Forex Trend Detector. During installation, select the installation folder of 
your MetaTrader4 terminal. This folder usually has the name of your broker and is 
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located in C:\Program Files 

(x86)  

 If you did not close your MetaTrader4 terminal before installing Forex Trend 

Detector, you will need to restart it now. 
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Installation By Copying 

 

1. Download the Forex Trend Detector EX4 file 

After logging in to the member zone with the username and password provided, 

download “ForexTrendDetector_vXX.ex4” and "forextrenddetector.bmp"  

files from your personal download page to a convenient location on your 

computer. 

 

2. Identify your "Application Data" folder 

First you need to locate your Application Data folder of the MT4. To do this, go to 

the File menu in the MT4 platform and click on "Open Data Folder" (check out the 

image below). 

 

 

 

3. Place your robot files in the right location 
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First thing to do is to open the MQL4 folder, which is in the "Application Data" 

folder (which you already see). The next steps are very easy: 

 Place your "ForexTrendDetector_vXX.ex4" file in the "Experts" folder 

inside the "MQL4" folder. 

 Place your "forextrenddetector.bmp" file in the "Images" folder inside 

the "MQL4" folder. 

 

    

 

4. Run the EA 

After you have successfully placed the files in the correct folder, all you need to 

do is to restart your MT4. If you have done everything correct, the EAs should 

appear in the "Navigator" Tab of your MT4. 
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Activating Forex Trend Detector 
 

 

To activate your copy of Forex Trend Detector for your demo and real accounts, 
log in to our member zone and then find the account activation page. Type your 
account number into the input field and click Activate. Repeat this procedure for 

each account. Use the demo accounts field to activate demo accounts, and the 
real-money account field to activate your real money account. 

 
Your Forex Trend Detector licence is valid for two demo accounts and for one 
real-money account. The licence is not tied to one computer. You are free to 

trade using your accounts on any computer at home, in the office, or VPS. 
 

You also have the option of removing any account you don’t use and activating a 
new one on its place. 
 

You should activate your demo or real account even if you only wish to backtest 
Forex Trend Detector.  

 
 

Your online authentication procedure may take some time.  

If you see an “Online Authentication Problem!” alert, wait a couple of 
minutes, or restart your MT4. If the problem persists, contact us at 

support@forextrenddetector.com 
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Starting and Configuring  
Forex Trend Detector 

 

 

After installing and activating Forex Trend Detector, launch your trading terminal 

and click Tools->Options. 

 

To ensure that Forex Trend Detector operates correctly, make certain that you 

have checked and unchecked all the boxes exactly as shown below. 
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Next, open the graph for the EURUSD currency pair and select the 5-minute 

timeframe, М5. 

 

 

 

You are now ready to place Forex Trend Detector on the chart. In the Navigator 

window, double click Expert Advisors to expand it and see all the Expert Advisors 

including Forex Trend Detector. Right click Forex Trend Detector and select 

Attach to a Chart, or simply drag it onto the chart. 
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After placing Forex Trend Detector on the chart, you should see a smiley face 

in the upper right hand corner of your chart. This indicates that the robot is 
running. If you don’t see a smiley face, click Properties on the menu bar and 

make certain that the Allow Live Trading box is checked. If it is checked and you 
still don’t see a smiley face, go to Tools on the menu bar and select Options. A 

popup will appear. Select the Expert Advisors tab and check both the Enable 
Expert Advisors box and the Allow Live Trading box.  
 

 
 

You can enable or disable Forex Trend Detector from the Expert Advisor button 
at any time. 
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Forex Trend Detector 

Settings 

 
 
   

To edit Forex Trend Detector Settings, right click anywhere on the chart 
and select Expert Advisors -> Properties. 

 
 

 
 

Forex Trend Detector continually updates its trading logic and settings 

from our web server. This happens absolutely automatically and requires 

no intervention from you. 
 

 
For all inexperienced FOREX traders, unfamiliar with the MT4 Terminal 

and EA trading, we offer a simplified version of Forex Trend Detector 

(ForexTrendDetectorSimple). This version has fewer options, but 

otherwise is fully functional. The only thing you should do is to attach it 

to the chart and let it run. And, of course you’re free to choose your own 

AutoMM, or FixedLots Settings. 
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Most of the settings are “expert’s settings” witch a regular, non-expert 

user wouldn’t normally need to touch. However, there are several values 

that must be set by you. These are marked in red in the list below. 

  

General Settings 
 

Magic - a unique identifier through which Forex Trend Detector recognises and 

manages its own positions.  

If you use other expert advisors on the same account, please ensure that each 

of them has a distinct, unique identifier. 

Never run more than one copy of Forex Trend Detector in the same account! 

 

Backtest_GMT_Offset - this parameter is very important for back-tests. 

If you do not enter the correct GMT Offset for the back-test history data 

loaded in your MT4 terminal, your back-tests will be incorrect. 

 

EA_Comment - enter comments here if you’d like to record comments about 

your Forex Trend Detector trades.  

       

MaxSpread - maximum allowed spread in standard 4-digit pips. You can also 

enter partial values.  

           

MaxSlippage - maximum allowed slippage in standard 4-digit pips. You can 

also enter partial values.  

            

StealthMode (true/false) - in this mode, StopLoss and TakeProfit levels in 

program logic are hidden (i.e. brokers can’t see them). If you use this mode, 

StopLoss and TakeProfit orders are not located in the trading server, which means 

if your trading terminal is not connected, or if the robot is not working, your 

orders are not protected. 
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Risk Management Settings 
     

RecoveryMode (true/false) - when RecoveryMode is activated, an algorithm 

effectively compensates the current drawdown by smoothly increasing trading 

volumes. This mode is active only when AutoMM is greater than zero. Before 

activating RecoveryMode, please bear in mind that it can increase the risk to your 

account. For this reason, RecoveryMode should only be used at low values of the 

AutoMM parameter. We recommend RecoveryMode with AutoMM values below 1.  

 

RecoveryMultiplier – the multiplication factor used from the 

RecoveryMode. The default value of RecoveryMultiplier is 1.05, which means that 

the trading volume of each next trade will be multiplied by 1.05, until the 

drawdown is not fully compensated. 

 

  

FixedLots - the extent of the fixed trading volume. If you use AutoMM>0, 

the value of the FixedLots parameter will make no difference.      

 

AutoMM - automatic risk management activates at values greater than zero: 

- Example 1: at AutoMM = 0.5, Forex Trend Detector opens positions equal to 0.05 lots (5,000) 

given account extent of 10,000. This places 0.5 per cent of the account extent at risk per individual 

transaction at a loss of 100 pips. 

- Example 2: at AutoMM = 2, Forex Trend Detector opens positions equal to 0.2 lot (20,000) given 

account extent of 10,000. This places 2 per cent of the account extent at risk per individual 

transaction at a loss of 100 pips. 

 

         

AutoMM_Max - the maximum permitted risk expressed as a percentage of 

the account per individual transaction, calculated on the basis of a 100 pip loss. 

When RecoveryMode is used, this parameter limits the upper value of the risk per 

trade.  

 

MaximalLots – maximum allowed lots 

 

MaxTrades – maximum allowed trades 

The default value is 10 trades, opened in 5 minute intervals in the direction of a 

strong market impulse. This could happen during very rare and very strong 

market impulses, which are the most profitable for Forex Trend Detector EA. The 

risk in situations like that, even with 10 open trades is minimal, because only a 

few of these trades could be closed at Stop Loss. In fact in 90% of the cases 

you will have up to 5 trades at a time. 
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Custom Expert’s Settings 
 

CustomTakeProfit – fixed custom Take Profit value in standard 4-digit pips. 

Works with values greater than zero. The default Take Profit value is provided by 

our server. 

 

CustomStopLoss – fixed custom Stop Loss value in standard 4-digit pips. 

Works with values greater than zero. The default Stop Loss value is provided by 

our server. 

 

TrailingStop – fixed Trailing Stop value in standard 4 digit pips 

 

 

StartTrailStop – the minimum profit of the position in pips, on which the 

Trailing Stop will start to be applied  

 

SafeExitMinutes – time in minutes, after which the position will be closed 

on a base of the SafeProfit parameter 

 

 

SafeProfit – profit/loss in pips on which the position will be closed, if the 

position live exceeded the value of the SafeExitMinutes parameter 

 

 

ExitSignalProfit – minimum profit in pips, on which the position will be 

closed by the aggressive profit protection trading logic 

 

 

ExitM5Profit – minimum profit in pips, on which the position will be closed, 

after the formation of M5 reversing bar 
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Risk Management Hints 

 

Risk management is with fundamental importance in attaining optimum trading 

results. It pays to think very carefully before deciding what percentage of your 

account to expose to risk in each individual transaction. 

 

Forex Trend Detector opens a maximum of 10 trades in the direction of the market 

impulse in at least 5 minute intervals. Having ten open trades at the same time is 

quite a rare occurrence. However all trades will be in the direction of a strong market 

impulse, all protected with tight stop losses and reasonable trailing stops. Our highly 

effective Profit Protection trading logic will take care of the positions closing them at 

reasonable profit levels. Even having 10 open trades at a time, means that you have very 

strong and potentially profitable market impulse, so the risk for your account will be 

minimal. If the system detects a false break and the market reverses, your exposition 

will be only one to several trades which will be closed at minimum 35 pips loss. In fact 

the most potentially profitable scenario is when you have a very strong market impulse 

with large number of trades executed in its direction.  

 

Here are some examples of trading scenarios: 

Excellent trading example with a lot of trades, all closed on profit 
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Relatively good trading example – several profitable and several loosing trades, closed at a 

summary small profit 

 

 

Bad trading example – several trades closed at 35 pips stop loss each 

 

 

In these trading examples you can see how Forex Trend Detector perfectly follows the 

“Smart Money” market impulse, increasing the trading exposition, only when the market 

breakout is confirmed with strong enough follow-through. If the market stalls Forex 

Trend Detector does not take unnecessary risks. 
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If your account is significant in extent and importance and you want to avoid 

taking unnecessary risks, then you should settle for AutoMM values between 0.5 

and 1 per cent risk per individual transaction.  

If your account is not significant in extent or importance, and if you can afford to 

assume significant risk, then you can probably afford to select AutoMM values 

between 2 and 5 per cent per individual transaction.  

For small accounts not significant in extent or importance you can start with 

larger risk like AutoMM=4-5. Then, if you get lucky and the EA manage to 

increase your account significantly it will be reasonable to reduce the risk in order 

to protect your profits. AutoMM between 0.5 and 1 provides an optimal 

efficiency of the “RecoveryMode -ON” drawdown compensating algorithm. 

 

Here are some examples - if you have a USD 10000 account free margin, 

then: 
 
- If AutoMM=0, the EA will trade with volume = parameter FixedLots (defaults 

FixedLots=0.01) 
 

- If AutoMM=0.5 (0.5 per cent risk) the EA will open 0.05 standard lot positions.  
 
- If AutoMM=1 (1 per cent risk) the EA will open 0.1 standard lot positions. 
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How To Back-Test 
Forex Trend Detector 

 

Please, don’t forget to ACTIVATE your DEMO or REAL 

Account, even if you only wish to Back-Test Forex Trend 

Detector!  

It is important to note that high quality history data is essential for the 

backtest results. Most MT4 brokers DON’T have records of their own 

history data, and the quality of the Metaquotes data they provide in the 

MT4 history center is very low. Since 2000, the highest quality history 

data has been available at the Alpari RU MT4 history center. We base all 

of our developments on this data. 

  

If you wish to back-test Forex Trend Detector, you should first download history 

from the MetaTrader history center:  

Click Tools -> History Center, or press the "F2" key on the keyboard. In the list, 

find the currency pair that you wish to back-test and double click to expand it. 

Click "1 Minute (M1)" and then click "Download". When the download process is 

finished, double click on "5 Minutes (M5)" and all periods to "Daily (D1)" to 

convert the M1 data. Close the "History Center" window. 
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To open the "Strategy Tester" window, click the "Strategy Tester" button on the 

MetaTrader menu, or press "Ctrl+R" on the keyboard. In the "Strategy Tester" 

window, choose "ForexTrendDetector_vXX", choose the EURUSD pair on the M5 

timeframe. Choose the "Every tick ..." method as shown below. Click "Start" to 

start the back-test.  
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The "Every tick" back-test is the most precise, but it is very slow. If you wish to 

save time you can run the back-test on the M1 timeframe using "Open price 

only ..." – this method will also be correct. 

 

 

 

 

We strongly recommend that you operate a DEMO 

Account before trading with REAL money!  

This will help you to become familiar with the way 

Forex Trend Detector operates, before you commit 

genuine funds to a REAL Money Account. 
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Terms of Use and Risk Disclosure 
 

U.S. GOVERNMENT REQUIRED DISCLAIMER 

FOREX trading has large potential rewards, but also large potential risk. You must be 

aware of the risks and be willing to accept them in order to invest in the FOREX markets. 

Don’t trade with money you can’t afford to lose. This is neither a solicitation nor an offer 

to Buy/Sell currencies, futures or options. No representation is being made that any 

account will or is likely to achieve profits or losses similar to those discussed on this web 

site. 

The past performance of any trading system or methodology is not necessarily indicative 

of future results. 

Trading foreign exchange on margin carries a high level of risk and is not suitable for all 

investors. The high degree of leverage can work against you. As with all investments, 

you should not invest money that you cannot afford to lose. Before deciding to invest in 

foreign exchange, you must carefully consider your investment objectives, level of 

experience, and risk appetite. Additionally, you must be aware of all the risks associated 

with foreign exchange trading and seek advice from an independent financial advisor. 

Past results are not necessarily indicative of future success. 

 

CFTC RULE 4.41 – HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE 

CERTAIN LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, SIMULATED 

RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT 

BEEN EXECUTED, THE RESULTS MAY HAVE UNDER-OR-OVER COMPENSATED FOR THE 

IMPACT, IF ANY, OF CERTAIN MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. 

SIMULATED TRADING PROGRAMS IN GENERAL ARE ALSO SUBJECT TO THE FACT THAT 

THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT. NO REPRESENTATION IS 

BEING MADE THAT ANY ACCOUNT WILL OR IS LIKELY TO ACHIEVE PROFIT OR LOSSES 

SIMILAR TO THOSE SHOWN. 

 

By using Forex Trend Detector, you acknowledge that you are familiar with these risks 

and that you are solely responsible for the outcomes of your decisions. We accept no 

liability whatsoever for any direct or consequential loss arising from the use of this 

product. It's to be noted carefully in this respect, that past results are not necessarily 

indicative of future performance. 

Your purchase Forex Trend Detector serves as your acknowledgement and representation 

that you have read and understand these TERMS OF USE and that you agree to be bound 

by such TERMS OF USE ("License Agreement"). 

Copyright Information 

 

REPRODUCTION AND OR TRANSLATION OF ANY PART OF THIS WORK BY ANY MEANS 

ELECTRONIC OR MECHANICAL INCLUDING PHOTOCOPYING BEYOND THAT PERMITTED 

BY COPYRIGHT LAW WITHOUT THE PRIOR WRITTEN PERMISSION OF THE PUBLISHER IS 

UNLAWFUL. 

 

Copyright © 2015 – Forex Trend Detector, www.forextrenddetector.com - All Rights 

Reserved 

  

Author: Forex Trend Detector’s Team  

Website: www.forextrenddetector.com 
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